
 
 
 
 
 
USER’S MANUAL 
 

 
 
 

Certified 

 
ISO 9001 

LaserAnimation SOLLINGER GmbH    Crellestr. 19/20    D-10827 Berlin 1 
Phone +49 (30) 780 963 00  Fax +49 (30) 780 963 25 

E-mail info@laseranimation.com    Internet www.laseranimation.com 

Copyright © LaserAnimation SOLLINGER GmbH. All rights reserved. 

 

 
 
 
 
 
 

ShowLine 
 
 
 

 



User‘s Manual  ShowLine 2025/08/08 

 
 

 
 
 

Certified 

 
ISO 9001 

LaserAnimation SOLLINGER GmbH    Crellestr. 19/20    D-10827 Berlin 2 
Phone +49 (30) 780 963 00  Fax +49 (30) 780 963 25 

E-mail info@laseranimation.com    Internet www.laseranimation.com 

Copyright © LaserAnimation SOLLINGER GmbH. All rights reserved. 

 

Contents 
 

1 Introduction .................................................................................................................................................... 3 
2 Installation ....................................................................................................................................................... 3 
3 Workflow ........................................................................................................................................................ 5 

3.1 Starting the Software ................................................................................................................................................................... 5 
3.2 Creating a New ShowLine File ................................................................................................................................................... 6 
3.3 Loading a Demo Show ................................................................................................................................................................. 9 
3.4 Loading an existing Lasergraph DSP Show ............................................................................................................................. 12 
3.5 Inserting Effects ........................................................................................................................................................................... 14 
3.6 Effect Pool Manager .................................................................................................................................................................... 16 
3.7 Inserting Media ............................................................................................................................................................................ 19 

3.7.1 Inserting Audio Files .......................................................................................................................................................... 19 
3.7.2 Inserting Videos .................................................................................................................................................................. 20 

3.8 Inserting Markers on the Timeline ........................................................................................................................................... 22 
3.9 Loop Mode ................................................................................................................................................................................... 23 
3.10 Control in ShowLine ................................................................................................................................................................ 24 
3.11 Connection LGRemote - ShowLine ...................................................................................................................................... 26 

4 Program Menu .............................................................................................................................................. 27 
4.1 Menu File ...................................................................................................................................................................................... 27 
4.2 Menu Edit ..................................................................................................................................................................................... 27 
4.3 Menu Track .................................................................................................................................................................................. 28 
4.4 Menu Setup .................................................................................................................................................................................. 30 
4.5 Menu View ................................................................................................................................................................................... 30 

5 Keyboard Shortcuts ..................................................................................................................................... 31 
6 Release Notes .............................................................................................................................................. 32 
 



User‘s Manual  ShowLine 2025/08/08 

 
 

 
 
 

Certified 

 
ISO 9001 

LaserAnimation SOLLINGER GmbH    Crellestr. 19/20    D-10827 Berlin 3 
Phone +49 (30) 780 963 00  Fax +49 (30) 780 963 25 

E-mail info@laseranimation.com    Internet www.laseranimation.com 

Copyright © LaserAnimation SOLLINGER GmbH. All rights reserved. 

 

1 Introduction 
 
The software "ShowLine" makes arranging laser effects with audio or video files simple and clear. All 
entries from one or more Lasergraph DSPs can be integrated into the timeline and synchronized 
with an audio- or video file. 
 
 
 

2 Installation 
 
The current software version is available for download on our website in the customer area. 
  

https://www.laseranimation.com/en/downloads 
 
ShowLine can be installed on a PC under Windows 7/8.1/10/11 (32 or 64 bit). 
 
The Lasergraph DSP(s) must have system software version 2013/11/05 or newer installed.  
 
Double click the downloaded file "ShowLine--YYYY-MM-DD.exe" to start installation and follow the 
instructions. 
 

 
 
 

https://www.laseranimation.com/en/downloads
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If not already done, create a write-enabled share, e.g. "DSP" under Windows which has to be 
accessible by the Lasergraph DSP. This share does not have to be entered in the FS Client Setup on 
the Lasergraph DSP. 
 

Note: 
If you want to check whether the Lasergraph DSP actually has access to the shared PC folder 
enter the following command in the command line of the Lasergraph DSP: 
 

CDD \\<network name of the PC>\DSP 
 

If the Lasergraph DSP finds the shared folder, the path will be displayed below the command 
line. If not, a red error message will be displayed. 
 
Limitation: Depending on the Windows version the number of Lasergraph DSPs which can 
connect to the share is limited. For instance, Windows XP Professional allows a maximum of 
ten connections. If more Lasergraph DSPs try to access the share, the ones which are denied 
to connect will display the error message "Out of resources". 

 
All ShowLine files (*.show) as well as the files from the connected Lasergraph DSPs (*.BOOT) will 
be saved to this folder. 
 
Lasergraph DSP BOOTs will be saved with the network name of the Lasergraph DSP. 
 
Each time a show is saved, e.g. "test_1.show", the software will save the previous version to a 
folder which is numbered according to the time of the backup. 
Up to nine backups are available in this way, for example: 
 

 
 

1. Current Lasergraph DSP BOOT (network name of the Lasergraph DSP: "Compact-1") 
2. Most recent backup 
3. Oldest backup 
4. Current ShowLine data  

 
 
 
 
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3 Workflow 
 
3.1 Starting the Software 
 
Start ShowLine.exe, select the share and click OK. 
  

 
 
 
The start screen of the program will be displayed: 
 

 
 

 
 
 

List of all effects (entries) in a trickfilm 

Timeline 

Projector tracks 

Media band (for audio/video) 

Information line 
Backward-, play-, forward- 

buttons Button for activating/deactivating  
a loop 

Time cursor 

Divider (movable) 

Effect bands for film tracks 
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3.2 Creating a New ShowLine File 
 
The trickfilms for a show are created using LGRemote, as before. 
 
ShowLine uses the Net Timecode for synchronization. The timecode source is selected 
automatically on the connected Lasergraph DSP when ShowLine is started. 
 

 
 
 
First load the desired trickfilm(s) on the Lasergraph DSP(s). 
 

Note: 
A concise description of the entries in the "Description" field makes working with ShowLine 
easier. The descriptions will be displayed in the effect pool of the program together with the 
entry numbers. 

 
 
Then select the desired Lasergraph DSP in the ShowLine program window that appears after 
selecting the menu entry "Track"  "New Track" and click OK: 
 

 
 

Note: 
All available Lasergraph DSPs will be displayed. Lasergraph DSPs which are already connected 
will be displayed in italics. 

 



User‘s Manual  ShowLine 2025/08/08 

 
 

 
 
 

Certified 

 
ISO 9001 

LaserAnimation SOLLINGER GmbH    Crellestr. 19/20    D-10827 Berlin 7 
Phone +49 (30) 780 963 00  Fax +49 (30) 780 963 25 

E-mail info@laseranimation.com    Internet www.laseranimation.com 

Copyright © LaserAnimation SOLLINGER GmbH. All rights reserved. 

 

A new projector track will be generated for the selected Lasergraph DSP, the DSP's network name 
and its IP address will be displayed: 
 

 
 
 
Each Lasergraph DSP has four film tracks. These can be assigned to the available DSPs (DSP 1-4) in 
the selection window. 
 
The green bar indicates that the Lasergraph DSP is available for ShowLine. As soon as ShowLine 
loses the connection to this Lasergraph DSP, the bar will be displayed in red. 
 
Display of the individual film tracks can be collapsed or expanded by clicking the small triangle in the 
top left corner. 
 
 

Notes: 
 

– Clicking on the laser symbol in the timeline will stop or start the laser output of all 
Lasergraph DSPs connected to ShowLine. 
 

– Clicking on the laser symbol in one projector track will stop or start the laser output of 
this projector. 
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In LGRemote there is the menu entry "External Connect" in the "Modes" menu. If this is activated, 
double clicking a projector track in ShowLine will cause LGRemote to connect to this Lasergraph 
DSP. This makes working with several Lasergraph DSPs in ShowLine easier. 
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3.3 Loading a Demo Show 
 

There are numerous demo shows for ShowLine which are available for download together with the 
software in the client section of our website. 

The selected *.zip file is saved to the folder shared for ShowLine on the PC and can then be 
decompressed.  

When opening a demo show the Lasergraph DSPs used in it have to be remapped to your own 
setup. That means the IP addresses of your Lasergraph DSPs have to be assigned to the IP 
addresses used in the demo show. 

 

Example: Demo Show "RageOfBattle" 

1. Open ShowLine and select menu File -> Open… 

2. Select the folder: 

 
3. Loading begins, the program tries to connect to the Lasergraph DSPs used in the show 

through their IP addresses 

 
4. and displays a warning for each one: 
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5. With "Ignore" resp. <Esc> loading will be continued until all Lasergraph DSPs used in the 
show are listed as projector tracks: 

 
The missing connection to the used Lasergraph DSPs is signaled with the red bar. 
 

6. Double clicking a projector track (see picture above) will open the Lasergraph DSP 
selection where you can assign the corresponding Lasergraph DSP to each projector track. 
 

 

Double click 
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In the example this is "Compact-1" for the first projector track and "Compact-2" for the 
second projector track: 
 

 
The green bars now show that both Lasergraph DSPs are available for ShowLine. 
 

If you save the show in ShowLine after remapping to your setup and reopen it later the films used 
by the show will automatically be loaded on the corresponding Lasergraph DSPs (if the IP addresses 
of the Lasergraph DSPs match the ones used in ShowLine).  
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3.4 Loading an existing Lasergraph DSP Show 
 

In order to load an existing Lasergraph DSP Show into ShowLine, first load the "Show.BOOT" into 
the Lasergraph DSP. Then save the Timescript to a shared folder on your PC which you can access 
from ShowLine later. 

Open ShowLine, create a new track, and connect it with the Lasergraph DSP. 

Now import the saved Timescript by clicking the menu item "Import Timescript…“. 

 
All entries listed in the Timescript will be displayed in Showline, according to their position in the 
Timescript. 

During the import process, Entry commands which do not initiate any action (all sections set to 
"Nochange") will be converted into markers. 

If the Timescript contains a "DefineMedia" and a "PlayMedia" command, name and start position of 
the media file will be inserted correspondingly, as well. A "StopMedia" command in the Timescript 
also defines the end of the media file. 
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If there is no "DefineMedia" command, no placeholder will be generated in the media track. 

Finally import the media file either by dragging and dropping the file into the media track, or by 
double-clicking the placeholder. 

After running the show, do not forget to save it to ShowLine. 
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3.5 Inserting Effects  
 
By clicking into the gray area behind a film, all effects (entries) of the selected film will be displayed 
in the effect pool with their entry numbers and descriptions: 
 

 
 
To insert an effect, left-click the effect you want to copy and drag it to the film track: 
 

 
 
Effects are always inserted with a length of ten seconds. Beginning and end can be changed by 
"gripping" them with the mouse. 
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An effect can only be dragged to the currently selected film track. 
 
Effects are copied by holding down the <Ctrl> key and moving the copied effect with the mouse 
to the desired position in the film track. 
 
To delete an effect from the film track, simply click it and press <Del>. 
 

Note: 
The effect pool window can be removed from the program window with the mouse, and 
placed and scaled separately. To do this, click on the title bar of the window and drag it to 
the desired position. 
 

 
 
Moving the window into the upper part of the program window or double clicking the title 
bar of the window will merge it back into the program window. 
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3.6 Effect Pool Manager 
 
The "Effect Pool Manager" enables you to easily copy single entries from different trickfilms and 
even different Lasergraph DSPs into another film, just by dragging and dropping. 
 
Load the desired trickfilm(s) into the Lasergraph DSP(s) and select the Lasergraph DSP(s) in the 
ShowLine program window (see 3.2 "Creating a New ShowLine File"). 
 
Open the "Effect Pool Manager" by either clicking the menu item "View"  "Effect Pool Manager", 
or by pressing <Ctrl><E> keyboard shortcut. 
 
The following window will pop up: 
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Clicking the menu item "Select Effect Pool" opens a drop-down list which shows you all Lasergraph 
DSPs used in ShowLine projector tracks. 
 
Left click the desired trickfilm and all entries of that film will be displayed in the window (effect 
pool) below. Proceed correspondingly on the other side. 
 

 
 
Now you can drag and drop the desired effects from left to right or vice versa and copy them into 
the other film. Just drag the entry into the bar "Drop here to create Effect". You can also drag the 
effect directly into the Effect Pool by holding down the <Ctrl> key at the same time. 
Added effects are highlighted in blue. 
 
You can also overwrite effects. Just drag the new effect over the one you wish to overwrite and 
drop it there. After verifying a confirmation message, the old effect will be replaced by the new one 
and is highlighted in green. 
 
You can also drag and drop effects within one Effect Pool. 
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If you copy an effect into an empty trickfilm, the effects will keep their original Entry numbers. 
 
In case an Entry number is already present in the target film, the Entry number of the copied effect 
will be converted to the lowest available Entry number. 
 
 
Notes: 

 
- If the Entry of the source film uses a different Subroutine number than the target film 

(GoSub / OnGoSub / ConditionalGoSub), the film cannot be compiled and you will see the 
following error message: 

 

 
 
 

- Caution is also required when a copied Entry contains a "Goto", "OnGoto" or 
"ConditionalGoto" command. If the destination Entry does not exist in the target film, you 
will also see the error message shown above. 
Otherwise the film might jump to an unwanted Entry. 

 
 

- Working with the Effect Pool Manager is only possible, when the Lasergraph DSP is in the 
start menu. In case you have just fixed one of the errors mentioned above, do not forget 
to close the [Edit] Mode, otherwise the following error message will appear: 
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3.7 Inserting Media 
 
Audio- and/or video files can be inserted into the media band. Two media objects can be placed 
beside each other seamlessly but they may not overlap. 
 
 
 
3.7.1 Inserting Audio Files 
 
ShowLine supports audio files in WAV, MP3 and WMA formats. 
 
To insert a file double click the media band, load the desired file and place it anywhere on the 
media track or drag & drop it into the media track. 
 
Audio files in WAV format are displayed as an envelope curve. 
 
Previously placed audio files can be moved at will on the timeline using the left mouse button: 

 

 
 
 
To remove an audio file click on it, hold the mouse button down and press <Del>.  
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3.7.2 Inserting Videos 
 
ShowLine supports the video formats AVI, MPG and WMV. 
 
Before inserting a video file, activate the option "Video" in the "View" menu. This will open the 
video window next to the "effect pool". 
 
To insert a file, double click the media band, load the desired video and place it anywhere on the 
media track or drag & drop it into the media track. 
 
The video file can be moved at will on the timeline using the left mouse button. 
 

 
 
 

Notes: 
 
– Double clicking into the video window will scale it to the size of the screen. Another 

double click will scale it back down. 
 

– The video window can be removed from the program window with the mouse, placed 
and scaled separately. Just click on the title bar of the window and drag it to the desired 
position. 
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– Moving the window into the upper part of the program window or double clicking the 
title bar of the window will merge it back into the program window.  

 
To remove a video file click on it, hold the mouse button down and press <Del>. 
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3.8 Inserting Markers on the Timeline 
 
Markers (red triangles) can be inserted on the timeline by mouse click. To delete them, click on the 
marker and press <Del> at the same time. 
Markers can also be inserted and deleted at the current position of the time cursor (green line) 
using the <M> key. 
 
Inserted markers can be moved using the mouse. Use <Tab> resp. <Shift><Tab> to jump from 
marker to marker. 

 

 
 

The snap function causes effects and media to be placed at the positions of markers or the current 
cursor position. The snap function is deactivated as long as the <Alt> key is pressed. 
 
The time cursor can be moved back and forth with the mouse. Right clicking on the cursor in the 
timeline opens the cursor window where the cursor position can be entered. 
 

 
 
Hold the right mouse button down to scroll within the timeline (hand cursor). Use the mouse 
wheel to zoom in the area around the mouse pointer. 
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3.9 Loop Mode 
 
The <I> and <O> keys are used to set loop markers in the timeline. <I> sets a loop-in marker 
defining the beginning of a loop, <O> sets the loop-out marker at the end of the loop. 
 

 
 
The markers can be moved individually with the mouse. 
 
The loop mode can be activated and deactivated with the loop button. When the loop mode is 
active only the effects and media sequences within the loop will be played back. 
 

 
 
 
Loop markers are deleted by clicking on the small triangle or the dotted line, holding the mouse 
button down and pushing <Del>. 

Loop mode 
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3.10 Control in ShowLine 
 
Clicking the play button or pushing the space bar will start the audio- resp. video file and the 
Lasergraph DSPs. The laser effects placed in ShowLine will be played back at the defined time 
synchronously to the audio- resp. video file. 
 
For monitoring the laser effects, the LGPreview window can be opened in the "View" menu. 
 

 
 
 
Use the forward- resp. backward buttons to jump from marker to marker in the timeline to the end 
of the last placed object or vice versa, back to the beginning of the timeline. 
 
The <End> and <Home> buttons can be used to directly reach the end of the last placed object 
(effects, media objects or markers), respectively the beginning of the timeline. 
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Notes: 
 

– <Ctrl><> sets the cursor to the previous and <Ctrl><> to the following 
marker. 
 

– <> moves the cursor one frame backwards, <> moves it one frame ahead.  
 

– <Shift><> moves the cursor one second backwards, <Shift><> moves it 
one second forwards. 
 

– In the active LGPreview window the <S> key opens the Lasergraph DSP selection. 
Alternatively, the Lasergraph DSP selection can be opened by clicking into the 
window with the right mouse button and selecting "Select DSPs". 
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3.11 Connection LGRemote - ShowLine 
 
The timescript on the connected Lasergraph DSP is deactivated when the Lasergraph DSP is 
connected to ShowLine. 
 
A double click on an effect in ShowLine will cause the timescript in the connected Lasergraph DSP 
to display the corresponding entry. 
 

 
 

 
 
 
Each time the play mode is started in ShowLine, the software will send the time information to the 
connected Lasergraph DSPs. Even though the timescript is not editable it will be displayed and can 
be monitored. 
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4 Program Menu 
 
 

  
 
 
 
4.1 Menu File 
 
New 
 Creates a new ShowLine file. 
 
Open... 
 Opens an existing ShowLine file. 
 
Save 
 Saves the current ShowLine file. 
 
Save as... 
 Saves the current ShowLine file under a new name. 
 
Exit 
 Closes ShowLine. 
 
 
 
 
4.2 Menu Edit 
 
Set Cursor… 
 Opens the dialog for specifying the cursor position. 
  
Toggle Marker 
 Sets a marker to the cursor position, an existing marker will be deleted.  <M> 
 
Set Loop In 
 Defines the beginning of a loop.  <I> 
 
Set Loop Out 
 Defines the end of a loop.  <O> 
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Define Offset… 
 Opens the window for setting the starting point on the timeline. 
 

  
 
 
Retime Show... 
 Adds/subtracts a certain period of time to/from the specified time in the timeline. 
 For this click on the + or - symbols in the window. 
  

  
 
 
 
4.3 Menu Track 
 
New Track... 
 Opens the Lasergraph DSP selection window and adds the Lasergraph DSP as a projector track. 
 
Duplicate Track 
 Copies the selected projector track, opens the Lasergraph DSP selection 
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and inserts the projector track on the selected Lasergraph DSP: 

   

 

Delete Track 
 Deletes the selected projector track. 

 

Move Track up 
 Moves the selected projector track upwards. 

 

Move Track down 
 Moves the selected projector track downwards. 

 
Import Timescript… 
 Loads a selected Lasergraph DSP Timescript (*.TSCR). 

 
Select Lasergraph DSP… 

Opens the selection window for selecting another Lasergraph DSP for the projector track. 
This can also be achieved by double clicking on the "Name/IP Address" of the Lasergraph DSP in 
the projector track. 
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4.4 Menu Setup 
 

Show Folder… 
 Opens the window for selection of a writable network share. 
 
Timeline… 

Here you can select whether ShowLine generates Net Timecode or synchronizes to incoming 
Net Timecode. 
 

 The resolution of the timeline can also be defined here. 
 Available values are 24, 25, 30 and 100 fps (frames per second). 
  

  
 
Language 
 Toggles between German and English. 

 

 

 

4.5 Menu View 
 

Default layout 
 Restores the default positions for all of the program's windows. 
 
Effect Pool 
 Turns the display of the effect pool on/off. 
 
Effect Pool Manager 
 Opens the Effect Pool Manager. 
 
Video 
 Turns the video window on/off. 
 
LGPreview 
 Starts or stops the LGPreview program. 
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5 Keyboard Shortcuts 
 

Shortcut Description 

<Ctrl><N> New file 

<Ctrl><O> Opens file 

<Ctrl><S> Saves file 

<Ctrl><Q> Closes program 

<Ctrl><Z> Undoes the last action 

<Ctrl><Y> Redoes the last action 

<M> Inserts marker at current time cursor position resp. removes it  

<I> Sets loop-in marker 

<O> Sets loop-out marker 

<Ctrl><E> Opens the Effect Pool Manager 

  

<Alt> Deactivates snap function while pressed 

  

<Shift><Tab> Sets cursor to previous marker 

<Tab> Sets cursor to following marker 

<Ctrl><> Sets cursor to previous marker 

<Ctrl><> Sets cursor to following marker 

<>  Sets cursor one frame back 

<> Sets cursor one frame ahead 

<Shift><> Sets cursor back one second 

<Shift><> Sets cursor ahead one second 

<Home> Sets cursor to the beginning of the timeline 

<End> Sets cursor to the end of the last placed object 

  

<F1> Starts the show 

<F2> Pauses the show 

<Space> Starts resp. pauses the show 

<Ctrl><L> Activates resp. deactivates the loop mode 
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6 Release Notes 
 

ShowLine 2025/08/08 

• Bug fix: The connection to the DSPs could get lost during save and load operations. 

 

ShowLine 2025/06/18 

• New: ShowLine can now synchronize to incoming Net Timecode. 

• LGPreview has been updated. 

 

ShowLine 2024/12/04 

• Effects are automatically shortened during drag & drop if there is not enough space to insert 
them into the timeline. 

• Bug fix: The maximum allowed length of the computer name was limited to 14 characters. 

 

ShowLine 2024/09/05 

• New: Automatic and manual software updates. 

• Bug fix: Moving the time cursor during playback could cause a crash. 

• LGPreview has been updated. 

 

ShowLine 2020/08/12 

• Improved compatibility with Windows 10. 

 

ShowLine 2017/02/28 

• New: Effect Pool Manager. 

• New: Keyboard shortcut <Ctrl><L> activates resp. deactivates the loop mode. 

• Improvements in stability and bug fixes. 
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ShowLine 2016/05/24 

• When the description of an entry is changed on the Lasergraph DSP, ShowLine will update 
the effects which were already placed. 

• Bug fix: In cases where the number of projector tracks was a multiple of five the effect pool 
was not updated correctly. 

• Bug fix: ShowLine crashed on some PCs when the program was started. 

 

ShowLine 2015/06/04 

• Double clicking a projector track causes LGRemote to connect to this Lasergraph DSP. 

• Minor improvements. 

 
ShowLine 2014/04/08 

• New installer solves compatibility issues with the 64-Bit versions of Windows. 

 

ShowLine 2013/10/17 

• First release 
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